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• Simulation Preparation

• The PDB and PSF files

• Solvate the System

• Simulation Environment

• Configure and Execute NAMD

• Load and Analyze Simulations in VMD

• Integrative Molecular Modeling with VMD and NAMD

Overview



What do we need to run a Simulation?
• Coordinates

• X-Ray or NMR, Homology Modeling (Rosetta 
or Modeller), Cryo-EM,…

• Structure Topology

• Atoms Types

• Bonds, Angles, Dihedrals and Improper 
Angles

• Description the Atoms’ Interaction

• Bonds, Angles, Dihedrals and Improper 
Angles Force Constants

• Non-Bonded Terms



Initial Structure

https://www.rcsb.org/
1ubq.pdb

• Experimental Information

• Sequence Annotations

• Rich Source of Information + Paper 

https://www.rcsb.org/


Initial Structure - 1ubq.pdb
 

• No Hydrogen Atoms
• Crystallographic Water Molecules and Ions
• Other Molecules
• Missing residues (Possible Sequence Gaps) -

Homology Modeling
• Poorly Defined Atom’s Position - MDFF or Fix 

Chiral Centers

PDB tools list: https://www.rcsb.org/pdb/static.do?p=software/software_links/analysis_and_verification.html
MolProbity: http://molprobity.biochem.duke.edu/ 
Structure Check Tutorial: https://www.ks.uiuc.edu/Training/Tutorials/#structcheck 
ModelMaker VMD plugin: https://www.ks.uiuc.edu/Research/ModelMaker/

https://www.rcsb.org/
https://www.rcsb.org/pdb/static.do?p=software/software_links/analysis_and_verification.html
http://molprobity.biochem.duke.edu/
https://www.ks.uiuc.edu/Training/Tutorials/#structcheck
https://www.ks.uiuc.edu/Research/ModelMaker/


What do we need to run a Simulation?

Bond

Angle

Dihedral

Improper

• Coordinates

• X-Ray or NMR, Homology Modeling (Rosetta 
or Modeller), Cryo-EM,…

• Structure Topology

• Atoms Types

• Bonds, Angles, Dihedrals and Improper 
Angles

• Mathematical Description the Atoms’ 
Interaction

• Bonds, Angles, Dihedrals and Improper 
Angles Force Constants

• Non-Bonded Terms



CHARMM Force Field
 

CHARMM Force Field Files:http://mackerell.umaryland.edu/charmm_ff.shtml
Force Field Tutorial:https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-
tutorial/forcefield-html/node5.html

In Short: Mathematical description of the interactions 
between atoms (bonded and not bonded) 
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Residue Topology 
File (RTF)

Parameter 
(PAR)

Stream 
(STR)

• Atoms
• Mass
• Charges

• Residues
• Patches 

(Modifications)

• Mathematical 
Constants 

• Topology
• Parameters

Force Field File Types:

https://www.rcsb.org/
http://mackerell.umaryland.edu/charmm_ff.shtml
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node5.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node5.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node5.html


Topology File - CHARMM Force Field
 

top_all36_prot.rtf - Protein 

Force Field Tutorial:https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-
tutorial/forcefield-html/node6.html

https://www.rcsb.org/
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html


Topology File - CHARMM Force Field
 

Residue’s 
Name

Total
Charge

Atoms’
Name

Atoms’
Type

Atoms’
Charge

Force Field Tutorial:https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-
tutorial/forcefield-html/node6.html

https://www.rcsb.org/
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html


Topology File - CHARMM Force Field
 

https://www.rcsb.org/


Topology File - CHARMM Force Field
 

Bond

Angle

Dihedral

Improper

Automatically Assignment of Angles and Dihedrals

Force Field Tutorial:https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-
tutorial/forcefield-html/node6.html

https://www.rcsb.org/
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html
https://www.ks.uiuc.edu/Training/Tutorials/science/forcefield-tutorial/forcefield-html/node6.html


Bond

Angle

Dihedral

Improper

Building Initial System
 

Structure Coordinates Structure Topology

PSFGEN

Complete Initial System
• Usually in form of PSF 

and PDB files
• Ready to Simulate
• No Solvent
• No Ions

https://www.rcsb.org/


PSFGEN
 
Structure Preparation Tool

Available at:

• NAMD

• VMD

• Stand Alone Tool

Additional Points to Be Aware During 

Structure Preparation:

• Protonation State (pKa)

• Histidine Residues Prot. State

• Special “Modifications”

• e.g. Group Heme

• Terminal Patches

TCL Interface Example:
package require psfgen
topology top_all36_prot_.rtf

pdbalias residue HIS HSE
pdbalias residue HOH TIP3
pdbalias atom ILE CD1 CD

pdbalias atom TIP3 O OH2

segment U {
   pdb ubqp.pdb
   first NTER

   last  CTER 
}

#patch DISU BPTI:5 BPTI:55   

coordpdb ubqp.pdb U
guesscoord

writepdb ubq.pdb

writepsf ubq.psf 

‘#’ Denotes Commented Line in TCL

Autopsf
• VMD Plugin

• Automates the PSF and PDB files Generation 

using PSFGEN 

• Graphical User Interface and Command Line

• Extensions -> Modeling -> Automatic PSF Builder

PSFGEN: https://www.ks.uiuc.edu/Research/vmd/plugins/psfgen/ug.pdf
PSFGEN Tutorial: https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-html/node5.html
Autopsf: https://www.ks.uiuc.edu/Research/vmd/plugins/autopsf/
PropKa: http://nbcr-222.ucsd.edu/pdb2pqr_2.0.0/

https://www.rcsb.org/
https://www.ks.uiuc.edu/Research/vmd/plugins/psfgen/ug.pdf
https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-html/node5.html
https://www.ks.uiuc.edu/Research/vmd/plugins/autopsf/
http://nbcr-222.ucsd.edu/pdb2pqr_2.0.0/


PSF Format  
(Generated by PSFGEN)

Atom 
Index

Seg.
Name

Res
ID

Res
Name

Atoms’
Name

Atoms’
Type

Atoms’
Charge

Atoms’
Mass

PSF Files: https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node23.html

https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node23.html


PDB Format
Atom 
Card

Atom
Index

Atom 
Name

Residue
Name

Chain
ID

Residue
ID X Y Z Occupancy Beta Seg. 

Name Element

PDB Files: https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node22.html
PDB Format: http://www.wwpdb.org/documentation/file-format

https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node22.html
http://www.wwpdb.org/documentation/file-format


What do we need to run a Simulation?
• Coordinates

• X-Ray or NMR, Homology Modeling (Rosetta 
or Modeller), Cryo-EM,…

• Structure Topology

• Atoms Types

• Bonds, Angles, Dihedrals and Improper 
Angles

• Description the Atoms’ Interaction

• Bonds, Angles, Dihedrals and Improper 
Angles Force Constants

• Non-Bonded Terms



Parameter File - CHARMM Force Field
 

Parameter Files: https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node25.html

https://www.rcsb.org/
https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node25.html


Solvate the Initial System
 
Water plays a crucial role in many biological system, even 

explicitly participating in enzymatic mechanisms.

Reason to Solvate a System

• Where Many Biological Processes Occur

• “Crowd Effect” and Electrostatic Contributions:

• Molecular Conformation, 

• Electronic properties, 

• Binding energies

Solvent Models:

• Explicit Water Models:

• Tip3p, Tip4p and Tip5p

• Implicit Solvent (Generalized Born Implicit Solvent in 

NAMD)

https://www.rcsb.org/


Solvate the Initial System
 
Water plays a crucial role in many biological system, even 
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Reason to Solvate a System

• Where Many Biological Processes Occur
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NAMD)

https://www.rcsb.org/


 
Why add ions?

• Protein might be sensitive to ionic strength of the 

surrounding solvent.

• The particle-mesh Ewald (PME - long-range electrostatic) 

calculation requires the system to be electrically neutral.

• Mimic experimental salt concentration

Why add membrane?

• Many proteins are membrane proteins, and their function 

critically depends on the physical and electrostatic 

influence of the membrane. 

Build Simulation Environment

https://www.rcsb.org/


 
Solvent Plugin

• Box Dimensions

• Box Padding

• Rotate to Minimize Volume

• Non Standard Solvent

• Graphical User Interface and 
Command Line

• Extensions -> Modeling -> Add 
Salvation Box

Solvate: https://www.ks.uiuc.edu/Research/vmd/plugins/solvate/
Solvate Tutorial: https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-
tutorial-unix-html/node7.html
Autoionize:https://www.ks.uiuc.edu/Research/vmd/plugins/autoionize/
Cionize: https://www.ks.uiuc.edu/Research/vmd/plugins/cionize/
Membrane Builder: https://www.ks.uiuc.edu/Research/vmd/plugins/
membrane/
Membrane Tutorial: https://www.ks.uiuc.edu/Training/Tutorials/#memprot
CHARMM-GUI: http://www.charmm-gui.org/?doc=input/membrane.bilayer
CellPack: http://www.cellpack.org/

Autoionize Plugin

• Neutralize

• Salt Concentration

• Mix of Ions

• Replace Water Molecules

• Graphical User Interface and 
Command Line

• Extensions -> Modeling -> Add Ions

• Cionize

Build Simulation Environment
VMD Membrane Plugin

• Pure POPC or POPE

• Command Line

CHARMM-GUI

• Comprehensive Simulation Preparation Tool

• A large variety of membranes composition 

and distribution

• Highly Mobile Membrane-Mimetic (HMMM) 

Model

https://www.rcsb.org/
https://www.ks.uiuc.edu/Research/vmd/plugins/solvate/
https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node7.html
https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node7.html
https://www.ks.uiuc.edu/Training/Tutorials/namd/namd-tutorial-unix-html/node7.html
https://www.ks.uiuc.edu/Research/vmd/plugins/autoionize/
https://www.ks.uiuc.edu/Research/vmd/plugins/cionize/
https://www.ks.uiuc.edu/Research/vmd/plugins/membrane/
https://www.ks.uiuc.edu/Research/vmd/plugins/membrane/
https://www.ks.uiuc.edu/Training/Tutorials/#memprot
http://www.charmm-gui.org/?doc=input/membrane.bilayer
http://www.cellpack.org/


• NAMD - “NAnosclae Molecular Dynamics”

• Parallel molecular dynamics simulations

• Free of charge

• Supports all major OS and platforms

• Supports NSF supercomputers, AWS cloud

• Supports NVIDIA GPUs, Intel Xeon Phi

• Sample of Features

• Diverse MD simulation flavors

• Enhanced sampling techniques

• QM/MM calculations

• Constant pH simulations 

• Efficient multiple replica simulations

Running NAMD



Configuring NAMD

NAMD Configuration File is a TCL Script File

• Setting Simulation Variables

• TCL Commands:

• For and while loops

• Conditional states

• Workflows and Algorithms 

• Temperature Ramp 

• Milestoning

NAMD Conf File: https://www.ks.uiuc.edu/Research/namd/
2.13/ug/node9.h

https://www.ks.uiuc.edu/Research/namd/2.13/ug/node9.h
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node9.h


Configuring NAMD I
Define Initial Structure

Define Variable “temperature”

Define Initial Temperature
Temperature Distribution

Define Restraints (e.g. backbone)
Uses an extra PDB file with beta 
column 1 to identify the atoms 
subject to the restraint

Output parameters
Printing into files or to the console 
is very expensive in terms of 
computation, harming the 
performance of NAMD if done to 
often

Input & Output Files: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node12.html
Temperature: https://www.ks.uiuc.edu/Research/namd/2.13b2/ug/node36.html
Constraints and Restraints: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node27.html

https://www.ks.uiuc.edu/Research/namd/2.13/ug/node12.html
https://www.ks.uiuc.edu/Research/namd/2.13b2/ug/node36.html
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node27.html


Configuring NAMD II
Definition of the 

Periodic Cell

Particle Mesh Ewald (PME) -
long range electrostatic interactions

Temperature Control Parameters - 
Thermostat

Pressure Control Parameters - 
Barostat

PBC: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node33.html
Temperature Control: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node36.html
Pressure Control: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node37.html

NPT - Constant Number 
of Particle, Pressure 

and Temperature

https://www.ks.uiuc.edu/Research/namd/2.13/ug/node33.html
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node37.html


Periodic Boundary Conditions

The use of PBC
• avoids surface effects
• permits particle mesh Ewald (PME) 

electrostatics
• permits pressure control

Points to Be Aware
• Size of the box
• Tumbling of the system
• Self interaction
• System’s volume tends to shrink during the 

initial steps of the simulation
• Can be a source of errors if the box 

shrinks too fast



Configuring NAMD III
Keep Molecules Inside the Periodic 
Cell. No Physical Value Changes, 

Only Its Representation 

Input Parameters Files

What Allows the 2fs Integration Step
Water Oxygen-Hydrogen bonds (opt = water)

Heavy Atom-Hydrogen bonds (opt = all)

PBC: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node33.html
Temperature Control: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node36.html
Pressure Control: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node37.html
Non-Bonded Int. : https://www.ks.uiuc.edu/Research/namd/2.13/ug/node23.html
Pair List: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node92.html

Multi Time Stepping
Integration time 2fs

Short Non-Bonded Interaction (2fs)
Full Electrostatics (PME - 4 fs)

Non-Bonded Parameters
Cutoff - VDW interaction

Switching - Smoothly Tend to 0
Pairlistdist - Dist. To Pair of Atoms in VDW 

Interactions
Stepspercyle - Cycles between evaluating PairList

https://www.ks.uiuc.edu/Research/namd/2.13/ug/node33.html
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node37.html
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node23.html
https://www.ks.uiuc.edu/Research/namd/2.13/ug/node92.html


Configuring NAMD IV
Minimize Potential Energy

Temperature Ramp (example of 
scripting)

Minimization: https://www.ks.uiuc.edu/Research/namd/2.13/ug/node34.html

Re-Set Temperature

Run Simulation for 1 ns (2 * 500.000 fs)

Example of Checking for Normal 
Termination of the Simulation

https://www.ks.uiuc.edu/Research/namd/2.13/ug/node34.html


Executing NAMD
Execute the command

• namd2 +p{number of processors} {Configuration File} > {Log File}

• namd2 +p8 namd.conf > logfile.log

• NAMD versions

• multicore -> multi CPU processors

• multicore-CUDA -> multi CPU processors + Nvidia GPU

• NAMD lists the GPUs (devices)

• +devices 0,1,2,3… defines the GPUs to be used

CharmLB> Load balancer assumes all CPUs are same.

Charm++> Running on 1 unique compute nodes (56-way SMP).

Charm++> cpu topology info is gathered in 0.017 seconds.

Info: Built with CUDA version 9010

Did not find +devices i,j,k,... argument, using all

Pe 4 physical rank 4 binding to CUDA device 4 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:c:0

Pe 3 physical rank 3 binding to CUDA device 3 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:8:0

Pe 5 physical rank 5 binding to CUDA device 5 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:d:0

Pe 0 physical rank 0 binding to CUDA device 0 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:4:0

Pe 6 physical rank 6 binding to CUDA device 6 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:e:0

Pe 2 physical rank 2 binding to CUDA device 2 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:7:0

Pe 1 physical rank 1 binding to CUDA device 1 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:6:0

Pe 7 physical rank 7 binding to CUDA device 7 on berlin.ks.uiuc.edu: 'TITAN V'  Mem: 12036MB  Rev: 7.0  PCI: 0:f:0

Info: NAMD Git-2019-05-08 for Linux-x86_64-multicore-CUDA

Info: 

Info: Please visit http://www.ks.uiuc.edu/Research/namd/

Info: for updates, documentation, and support information.

Info: 

Info: Please cite Phillips et al., J. Comp. Chem. 26:1781-1802 (2005)

Info: in all publications reporting results obtained with NAMD.

Info: 

Info: Based on Charm++/Converse 60800 for multicore-linux64-iccstatic

Info: Built Wed May 8 02:23:17 CDT 2019 by jim on belfast.ks.uiuc.edu

Info: 1 NAMD  Git-2019-05-08  Linux-x86_64-multicore-CUDA  8    berlin.ks.uiuc.edu  jribeiro

Info: Running on 8 processors, 1 nodes, 1 physical nodes.

Info: CPU topology information available.

Info: Charm++/Converse parallel runtime startup completed at 8.5059 s


NAMD version

When NAMD was built

How many CPU processors



Analyzing Trajectories

Load Trajectories (dcd) Files Into VMD:

• Using the Menu:

•  File-> “New Molecule” - Select PSF file first (recommended)

• File-> “New Molecule” -  Select the dcd file

• Command Line:

• “mol new Ubiquitin_QwikMD.psf”

• mol addfile traj.dcd waitfor all 

VMD Load Traj: https://www.ks.uiuc.edu/Training/Tutorials/vmd/tutorial-html/node3.html

https://www.ks.uiuc.edu/Training/Tutorials/vmd/tutorial-html/node3.html


Analyzing Trajectories

• TimeLine Plugin

• Temporally changing per-residue attributes of a molecular 
structure

• RMSD Trajectory Tool

• Root Mean Square Deviation calculator and visualizer

• Normal Mode Wizard <-> ProDY

• Analysis and visualization of normal mode data

• pyContacts:

•  Python plugin for VMD to non-covalent interactions

• MDAnalysis

• Object-oriented Python library to analyze trajectories VMD Analysis: https://www.ks.uiuc.edu/Training/Tutorials/vmd/tutorial-html/node7.html
Analysis Script: https://www.ks.uiuc.edu/Research/vmd/current/ug/node200.html
VMD Timeline: https://www.ks.uiuc.edu/Research/vmd/plugins/timeline/
VMD Plugins: https://www.ks.uiuc.edu/Research/vmd/plugins/
pyContacts: https://pycontact.github.io/
MDAnalysis: https://www.mdanalysis.org/

https://www.ks.uiuc.edu/Training/Tutorials/vmd/tutorial-html/node7.html
https://www.ks.uiuc.edu/Research/vmd/current/ug/node200.html
https://www.ks.uiuc.edu/Research/vmd/plugins/timeline/
https://www.ks.uiuc.edu/Research/vmd/plugins/
https://pycontact.github.io/
https://www.mdanalysis.org/


Integrative MD Toolkit for Novices and Experts

QwikMD is a VMD plugin to assist the user in 
preparing, executing and analyzing MD 
simulations. Features

• Easy Setup of MD 
Simulations

• Structure Manipulation
• Basic and Advanced 
Protocols

• Live View Simulations
• Integrated Analysis
• Info Buttons
• Reproducibility
• Available on Amazon 
Cloud



QwikMD Workflow

Features
• Easy Setup of MD 
Simulations

• Structure Manipulation
• Basic and Advanced 
Protocols

• Live View Simulations
• Integrated Analysis
• Info Buttons
• Reproducibility
• Available on Amazon 
Cloud



Initial Structure

Structure Check
• Missing topologies
• Sequence Gaps
• Residues Alternative 
Insertions

• Chiral Centers
• Cis-peptide Bonds
• Backbone Torsion 
Angles
- Marginals
- Outliers

Chiral Centers
D-amino acids

Cis-peptide



Structure Manipulation

Structure Manipulation
• Point Mutations
• Protonation State 
Selection

• Partial Sequence 
Deletions

• Molecule’s Type
• Assign Topologies
• Atom Editing

- Name
- Indexes Tyrosine Alanine



Simulation Environment

Simulation Environment
• Solvent Model
• Salt Concentration
• Water Box Size

- Reduced Volume 
Available

• Membrane Protein 
Insertion

Vacuum Implicit Solvent

Explicit Solvent Explicit 
Solvent + Membrane



Simulation Protocols

Simulation Protocol
• Molecular Dynamics
• Steered Molecular 

Dynamics
- AFM

• Molecular Dynamics 
Flexible Fitting (MDFF)

- cryo-EM Densities
• Quantum Mechanics / 

Molecular Mechanics 
(QM/MM) Simulations

- MOPAC and ORCA

Molecular Dynamics Steered MD

QM/MMMDFF



Full Control of QM Package 
Execution:

• Execution Command Lines as 
Arguments (ORCA & MOPAC)

• Wrapper Scripts
• Flexible Definition of QM Regions and 

QM/MM Bonds scheme

MOPAC

TeraChem GAUSSIAN

Q-CHEM

ORCA

NAMD QM/MM Interface
http://www.ks.uiuc.edu/Research/qmmm/

Nature Methods 2018
 
NAMD goes quantum: an integrative suite for hybrid 
simulations
Marcelo Melo, Rafael Bernardi, Till Rudack, Maximilian 
Scheurer, Christoph Riplinger, James Phillips, Julio Maia, 
Gerd Rocha (MOPAC), João Ribeiro, John Stone, Frank 
Neese (ORCA), Klaus Schulten, Zaida Luthey-Shculten

QwikMD Interface

• QM Region Definition:
- VMD Atom Selection
- Point-and-Click

• Multiple Independent QM 
Regions

• Prevent QM Region 
Definition Errors

• Detection and Definition 
of QM/MM Bonds from 
Protein and Nucleic Acid 
residues

• Q M O r b i t a l s a n d 
Energies Analysis

http://www.ks.uiuc.edu/Research/qmmm/
http://www.ks.uiuc.edu/Research/qmmm/
http://www.ks.uiuc.edu/Research/qmmm/
http://www.ks.uiuc.edu/Research/qmmm/
http://www.ks.uiuc.edu/Research/qmmm/


QwikMD and Reproducibility

Reproducibility
• All Steps Logged
• Loading Script and 
Text Log Files

• Reproduce and/or 
Share the Process to 
the End Result

Text File:
• Struct Man. Info
• File Locations
• MD Protocols details:

- Temperatures
- Steps
- Method section (with 

references)

• Auxiliary Files
• Intermediary PDBs
• Intermediary PSFs
• Renumber Residues Table 
• Topology+Parameter Files

• MD Configuration Files
• PDB Files
• PSF Files
• Parameter Files
• Simulation Log Files
• Simulation Trajectories

Setup 
Folder Run Folder

“InputFileName” 
Folder

“InputFileName.infoMD” 
File

“InputFileName.qwikmd” 
File



QwikMD and Reproducibility

Reproducibility
• All Steps Logged
• Loading Script and 
Text Log Files

• Reproduce and/or 
Share the Process and 
the End Result

“InputFileName.infoMD” 
File

“InputFileName.qwikmd” 
File

QwikMD 

Inputfile
“Methods 

Section” 

format



Load Simulation Trajectories 
and Analysis

Analyses Available:
• Energies
• Temperature, Pressure 
and Volume

• RMSD
• Hydrogen Bonds
• SASA
• Contact Area
• QM Energies

Live Simulation and 
After Load Analysis

Contact Area
First Implemented in CompASM as 

Hot Spots Filter

Ligand SASA
Ligand SASA in 
the presence of 
the Receptor

subtracted

Ligand Exposed/Contact 
Surface Area



Live Simulation and 
After Load Analysis

Contact Area
First Implemented in CompASM as 

Hot Spots Filter

Schoeler	 C.,	 et	 al.,Ultrastable	 cellulosome-adhesion	
complex	tightens	under	load,	Nat.	Commun.,	2014,	6,	5635.	

Load Simulation Trajectories 
and Analysis

Analyses Available:
• Energies
• Temperature, Pressure 
and Volume

• RMSD
• Hydrogen Bonds
• SASA
• Contact Area
• QM Energies



New QM/MM Simulation and Orbitals 
Visualization

Analyses Available:
• Energies
• Temperature, Pressure 
and Volume

• RMSD
• Hydrogen Bonds
• SASA
• Contact Area
• QM Energies
• QM Orbitals 
Visualization

• Nature Methods 2018



Analyses Available:
• Energies
• Temperature, Pressure 
and Volume

• RMSD
• Hydrogen Bonds
• SASA
• Contact Area
• QM Energies
• QM Orbitals 
Visualization

• Nature Methods 2018

New QM/MM Simulation and Orbitals 
Visualization



Other Features:
• Info Buttons
• Simulation Controls

QwikMD Graphical User Interface
Simulation Preparation Struct. Manipulation Simulation Analysis

Atom 
Editing



Molefacture Interface	

• Design Molecules from 
Scratch 

• Edit Existing Molecules  

• Use Templates for Quick 
Design 

• Molecule and Functional 
Groups Library 

• Minimize Structure with 
NAMD or OpenBabel

• Protein Editor 

• Export Structure to: 

• PSF/PDB 

• MOL2 

• XYZ 

• Interface with ffTK and 
QwikMD

Small Molecules Modeling in VMD



Molecular Tools Interface	

• Contiguous Use of the 
Modeling tools 

• Direct Communication 
Between the Tools 

• Easy-to-Use
• No Scripting Required

Integrated Molecular Modeling Environment



Alex Mackerell – University 
of Maryland 

Benoit Roux – University 
of  

Chicago

ffTK 
GUI

Molecular Tools Interface	

• Assign Atoms’ Type and 
Parameters with 
CGenFF Server 

• Parameters Refinement 
with ffTK and GAAMP

• Structure Refinement 
with MDFF Gui

• VMD Modeling 
Ecosystem

VMD Modeling ToolsExternal Tools

MDFF 
GUI

Molefacture

QwikMD

Molecular Modeling Environment 



QwikMD Papers
Ribeiro, J. V, et al., QwikMD  —  Integrative 
Molecular Dynamics Toolkit for Novices and 
Experts. Scientific Reports, 2016, 6, 26536. 

QwikMD:
• Scientific Reports
• BPS 2016
• BPS 2017
• BPS 2018
• ACS 2018
• ACS 2019 (Fall)

Melo, M. C. R., et al.,  NAMD goes quantum: an 
integrative suite for hybrid simulations. 
Nature Methods. 2018, 15:5 

http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
https://www.nature.com/articles/nmeth.4638
https://www.nature.com/articles/nmeth.4638
https://www.nature.com/articles/nmeth.4638
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536
http://www.nature.com/articles/srep26536


Dissemination, Documentation and User 
Support

www.ks.uiuc.edu/Research/qwikmd

Webpages:
• Home page
• User’s Guide Page

User’s Guide

http://www.ks.uiuc.edu/Research/qwikmd
http://www.ks.uiuc.edu/Research/vmd/plugins/qwikmd/


Dissemination, Documentation and User 
Support

Webpages:
• Home page
• User’s Guide Page
• VMD Mailing List
• NAMD Mailing List

vmd-l@ks.uiuc.edu

namd-l@ks.uiuc.edu

http://www.ks.uiuc.edu/Research/vmd/mailing_list/vmd-l/
http://www.ks.uiuc.edu/Research/namd/mailing_list/namd-l.2016-2017/


QwikMD beta Version – Latest 
Developments

QwikMD beta:
• Latest 
Implementations

• Bug Fixes
• Available Before VMD 
Release

www.ks.uiuc.edu/Research/qwikmd

http://www.ks.uiuc.edu/Research/qwikmd


Amazon Web Services:
• Virtual Machine
• VMD & NAMD
• QwikMD and MDFF
• Used in the Center’s 
Workshops

QwikMD on the Amazon Cloud

• http://www.ks.uiuc.edu/Training/Workshop/Urbana2017a/
• http://www.ks.uiuc.edu/Training/Workshop/Urbana2018
• http://www.ks.uiuc.edu/Research/cloud/

http://www.ks.uiuc.edu/Training/Workshop/Urbana2017a/
http://www.ks.uiuc.edu/Training/Workshop/Urbana2018
http://www.ks.uiuc.edu/Training/Workshop/Urbana2017a/
http://www.apple.com


Training others...

Webpages:
• Home page
• User’s Guide Page
• VMD Mailing List
• NAMD Mailing List

Workshop Live-Streamed on Facebook
QwikMD Tutorials QwikMD on Amazon

https://www.youtube.com/user/tcbguiuc




